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SCC-C020 Isolated Current
Output Module

The SCC-CO20 is an isolated current output module that outputs up to
20 mA. The output current level is proportional to the voltage applied to
the module by an analog output channel of an E/M Series DAQ device.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent
a range of values associated with a bit or signal name—for example,
AO <3..0>.
» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

> &

é When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

ﬁ When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.
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italic

monospace

SC-2345

SCC

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-CO20, you need the following items:

U Hardware
—  SC-2345/2350 with one of the following:
*  SCC-PWRO1
e SCC-PWRO02 and the PSO1 power supply

*  SCC-PWRO03 (requires a 7 to 42 VDC power supply,
not included)

—  One or more SCC-CO20

—  68-pin E/M Series DAQ device
—  68-pin cable

—  Quick Reference Label

U Software
—  The latest version of NI-DAQmx

U Documentation
—  SCC-CO20 Isolated Current Output Module User Guide
- 8C-2345/2350 User Manual
—  SCC Quick Start Guide
—  Read Me First: Safety and Radio-Frequency Interference
—  Documentation for your hardware

—  Documentation for your software
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QO Tools
— 1/8 in. flathead screwdriver
— Numbers 1 and 2 Phillips screwdrivers

—  Wire insulation stripper

@ Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the SCC-CO20 Module Pin Assignments section.

You can download NI documents from ni . com/manuals. To download
the latest version of NI-DAQmzx, click Download Software at ni . com.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2345/2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni . com/manuals.

Installing the SCC-C020

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

Plug the SCC-CO20 into either SC-2345/2350 analog output socket
J(X+17), where X is 0 or 1. The SC-2345/2350 routes the voltage output of
E/M Series DAQ device analog output channel AO (X) to the SCC-CO20.

Connecting the SCC-C020 to a Load

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg
to confirm the signal names.

The screw terminals are labeled by pin number <1..3>. Pin 1 is the ground,
pin 2 is the current sink, and pin 3 is the isolated loop supply. Figure 1
shows how the ground, sink, and supply connect to the E/M Series DAQ
device.
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E/M Series
DAQ Device

SCC-C020

AO (X)

AO GND

15Viso

Figure 1. SCC-C020 Signal Connections to E/M Series DAQ Device

Using the Isolated Loop Supply of the SCC-C020

You can connect the SCC-CO20 to a load using either the isolated internal
loop supply or an external supply. The internal loop supply outputs a
voltage of 15 V with respect to the isolated ground reference. When using
the internal loop supply, the compliance voltage is 12.5 V. This allows for
a maximum load resistance of 625 Q at 20 mA. Figure 2 shows how to
connect the SCC-CO20, using the internal loop supply, to a nonreferenced

(floating) load and to a load with a high common-mode voltage.

SCC-CO20

3 |SUPPLY

15Viso

Load

SINK

SCC-C020
3 |SUPPLY
|
15V iso 0_2@ Load
2
SINK
"

High
cMV

Figure 2. Connecting the SCC-C020 Using the Internal Loop Supply
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@ Note If your load is grounded and you are using the internal supply, connect the load
ground to the current sink terminal at pin 2 on the SCC-CO20. Do not connect the load
ground to the isolated ground terminal because doing so could defeat the module isolation.

Driving Higher-Resistance Loads with the SCC-C020

In order to calculate the supply voltage your application requires, multiply
the load resistance by the current you need to sink, then add 2.5 V for the
voltage drop across the protection diode and the current-sink MOSFET.
If you need a higher voltage than the 15 V provided by the internal loop
supply, you can either add a second SCC-CO20 module or provide an
external loop supply.

Adding a Second SCC-C020 Module

You can add another SCC-CO20 loop supply to create a supply of 30 V,
as shown in Figure 3. Do not use more than two SCC-CO20 modules on
a single circuit, because the resulting voltage can cause overheating and
damage the modules and other equipment.

© National Instruments Corporation 5 SCC-C020 Isolated Current Output Module User Guide



SCC-C0O20

Load

SUPPLY
15Viso
1ISO GND
SCC-C020
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Figure 3. Connecting Two SCC-C020 Modules to a Higher-Resistance Load
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Using an External Loop Supply

In order for the current sink to operate properly with an external loop
supply, the voltage must be within the range of 3 to 42 V. If the voltage is
too high, overheating can occur and damage the module. Figure 4 shows
four configurations using an external loop supply.

SCC-C020 SCC-C0O20
2 |SINK 2 |SINK
Load
0-20 mA 0-20 mA
Load
1 |ISO GND 1 [ISOGND
a. Nonreferenced load and external voltage supply (two circuits)
SCC-C0O20 SCC-C020
2 |SINK 2 |SINK
Load
0-20 mA 0-20 mA
Load
_1 |ISO GND 1 |[ISO GND
High High
CMV CMV
b. Referenced load and external voltage supply (two circuits)

Figure 4. Connecting the SCC-C020 Using an External Loop Supply

When you use an external loop supply, the order of the supply and load does
not matter as long as you do not create a second loop through which current
flows. If both the supply and the load are grounded, connect the signals as
shown in Figure 5.
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SCC-C020
2 |SINK

0-20 mA

1 [ISO GND

Load

Va4

Figure 5. Connecting the SCC-C020 to a Grounded External Loop Supply
and a Grounded Load

For information about how to configure the SCC-CO20 module using
NI-DAQmx, refer to the SCC Quick Start Guide.

Calibrating Gain and Offset Errors

The SCC-CO20 is calibrated at the factory before shipment. If you want
to adjust the gain and offset of the SCC-CO20 in your system using an
E/M Series DAQ device, you need a current meter (ammeter) with an
accuracy of at least +2 UA.

To adjust the gain and offset of the SCC-CO20, complete the following
steps:

1. Disconnect the load from the SCC-CO20 you want to calibrate.

2. Set an output range of 0 to 10 V for AO (X), the E/M Series DAQ
device channel connected to the SCC-CO20.

3. Connect the negative lead of the ammeter to the current sink (pin 2)
and the positive lead to the current supply (pin 3) of the SCC-CO20.

4. Using your software, have AO (X) output 10 mVDC.

Adjust the offset potentiometer on the top of the SCC-CO20 until the
ammeter reads 20 [LA. The offset is now calibrated.

6. Using your software, have AO (X) output 9 VDC.

Adjust the gain potentiometer on the top of the SCC-CO20 until the
ammeter reads 18 mA. The gain is now calibrated.
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@ Note Normally you would adjust to O HA in order to calibrate the offset, but because
the SCC-CO20 cannot source current, it is impossible to know when you have adjusted
past 0 HA.

Using the SCC-C020

The SCC-CO20 is a 0 to 20 mA programmable current sink. The current
output is controlled by AO (X), a 0 to 10 V unipolar DAC output channel
of an E/M Series DAQ device. The relationship between the AO (X)
voltage level and the current output of the SCC-CO20 is linear and is
described by the following equation:

Viow _
500 C020

where
Vao x) is the AO (X) voltage level.

Ic029 1s the SCC-CO20 current output in amperes.

The current sink is an N-channel power MOSFET sink to an isolated
ground reference. You can use the SCC-CO20 with industry-standard
0 to 20 or 4 to 20 mA current loops.

@ Note The current sink does not source current. If the input voltage is O V or less,
the module sinks 0 mA.

Isolated Ground Reference

Each SCC-CO0O20 module is referenced to its own isolated ground. Each
isolated ground can have up to 60 VDC of common-mode voltage between
itself and any other channel ground or chassis ground. Refer to the
Connecting the SCC-CO?20 to a Load section for different ways to use
the isolated ground in signal connections.
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Specifications

Electrical

These ratings are typical at 25 °C unless otherwise stated.

Number of output channels..................... 1

Output referencing.........coccevveveeereneennenne Nonreferenced (floating)
Input range........ccceeveeveereecieniecenieieee Otol0V

OULPUL TANZE ..coeveenvveeeeiieeieeeee e 0 to 20 mA

Voltage compliance ...........ccoceveevuereennene 125V

Maximum load resistance

Power Requirement

SMA e 2,500 Q
TOMA (e 1,250 Q
ISMA o 830 Q
20 MA .ot 625 Q
Absolute accuracy.........cceeceeeeereereesienneens 0.1% of full-scale output range
Temperature drift........cccccocerveneniiencnnns 0.5 HA/°C typ
1 HA/°C max
Analog POWET ......coceevvirveniinieienieeieieee 175 mW max
FIS Vo 5.8 mA max
ISV 5.8 mA max
Digital power (+5 V) cooeeieiiiiiieieee 645 mW
OV 129 mA max
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Physical

1.87 cm

(0.74in.) 7

, " .93 cm !
4 — L P
! . (8.121in.) !

L T
- 3.55cm
- (1.4in.)
Figure 6. SCC-C020 Dimensions
Weight ..., 28 g (1.0 0z)
I/O connectors .........cceeeeveeeeneeneenenen. One 20-pin right-angle male
connector
One 3-pin screw terminal
Field-wiring diameter.........c..cccccoceenuenee. 28to 16 AWG

Maximum Working Voltage

(Signal + common-mode) each input should remain within 42.4 V. or
60 VDC of ground.

Maximum working voltage refers to the signal voltage plus the CMV.

Channel-to-earth (inputs) .......cc.cceeveeneee. 42.4 Veq 01 60 VDC,
Measurement Category I

Caution This device is rated for Measurement Category I and is intended to carry signal
voltages no greater than 42.4 V., or 60 VDC. Do not use this device for connection to
signals or for measurements within Categories II, III, or I'V.

Isolation Voltage

Channel-to-earth isolation

ContinuUOUS ......ccoeeeeeeeeeeeeeeeeenen 60 VDC,
Measurement Category I
Withstand .......cccceeveeniieniiinnieniennen. 2300 V,,¢ verified by a5 s

dielectric withstand type test
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Environmental

Operating temperature ..........cc.cceceevverneee 0to 50 °C

Storage temperature..............ccoeeeeruennnes —20to 70 °C

Humidity ....cccocevineniniicicicieecccceeee 10 to 90% RH, noncondensing
Maximum altitude...........oooovvvevevinrnnnnne 2,000 m

Pollution Degree (indoor use only) ........ 2

Safety

This product meets the requirements of the following standards of safety
for electrical equipment for measurement, control, and laboratory use:

« IEC61010-1, EN 61010-1
« UL 61010-1, CSA 61010-1

@ Note For UL and other safety certifications, refer to the product label or the Online
Product Certification section.

Electromagnetic Compatibility

This product meets the requirements of the following EMC standards for
electrical equipment for measurement, control, and laboratory use:

e EN 61326 (IEC 61326): Class A emissions; Basic immunity
e EN 55011 (CISPR 11): Group 1, Class A emissions

e AS/NZS CISPR 11: Group 1, Class A emissions

e FCC 47 CFR Part 15B: Class A emissions

e ICES-001: Class A emissions

@ Note For the standards applied to assess the EMC of this product, refer to the Online
Product Certification section.

@ Note For EMC compliance, operate this product according to the documentation.
@ Note For EMC compliance, operate this device with shielded cables.

CE Compliance C €

This product meets the essential requirements of applicable European
Directives as follows:

*  2006/95/EC; Low-Voltage Directive (safety)
e 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

SCC-C020 Isolated Current Output Module User Guide 12 ni.com



Online Product Certification

Refer to the product Declaration of Conformity (DoC) for additional
regulatory compliance information. To obtain product certifications and
the DoC for this product, visitni . com/certification, search by model
number or product line, and click the appropriate link in the Certification
column.

Environmental Management

=l

NI is committed to designing and manufacturing products in an
environmentally responsible manner. NI recognizes that eliminating
certain hazardous substances from our products is beneficial to the
environment and to NI customers.

For additional environmental information, refer to the NI and the
Environment Web page at ni . com/environment. This page contains the
environmental regulations and directives with which NI complies, as well
as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)

EU Customers At the end of the life cycle, all products must be sent to a WEEE recycling
center. For more information about WEEE recycling centers and National Instruments
WEEE initiatives, visit ni . com/environment /weee.

RFEEFRISEREFNERME (PE ROHS)

FEZERF National Instruments 74 FE HL T B b BRI S0 45464 (RoHS).
%F National Instruments 1[5 RoHS A #i#E(E &, %% ni. com/environment /rohs_china.
(For information about China RoHS compliance, go fo ni. com/environment/rohs_china.)
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SCC-C020 Module Pin Assignments

Figure 7 shows the I/O connector pins on the bottom of the module.

/@

0000000000
00 0000000 o*+—2
1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin 20

Figure 7. SCC-C020 Bottom View
Table 1 lists the signal connection corresponding to each pin.

Table 1. SCC-C020 Pin Signal Connections

Pin Number Signal
1 E/M Series AO (X)
2 E/M Series AO GND
3 —
4 E/M Series AO GND
5 _
6 _
7 —
8 —
9 +5V
10 GND
11 —
12 +5 V REF
13 +15V
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Table 1. SCC-C020 Pin Signal Connections (Continued)

Pin Number Signal

14 -15V
15 —
16 —
17 —
18 —
19 —
20 —

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.

Refer to the Terms of Use section on ni . com/legal for more information about National

Instruments trademarks. Other product and company names mentioned herein are trademarks or trade

names of their respective companies. For patents covering National Instruments products/technology,

refer to the appropriate location: Help»Patents in your software, the patents. txt file on your

media, or the National Instruments Patent Notice at ni . com/patents.
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